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Chapter

1
Upgrading to ShowCase Essbase 7.1

Introduction

This guide will help you upgrade your ShowCase Essbase 4.5, 6.2, 6.5, or 6.51 production
environment to ShowCase Essbase 7.1 running on OS/400 V5R1, V5R2, or V5R3. The procedures
in this guide help you reduce migration problems and downtime for your production data.

This version of ShowCase Essbase includes Essbase Integration Services (EIS) 7.1. If you are
licensed for this option, pay special attention to the steps in this guide related to EIS.

Essbase 7.1 should be installed into a separate directory when running on a system with
STRATEGY 6.5 or ShowCase Suite 7.0.

Important: In STRATEGY 4.5, all STRATEGY, Essbase, and Analyzer applications were shipped on the
same CD. Beginning with ShowCase Suite 6.5, Essbase and Analyzer are separately installed products.
Depending on which products you purchased, the ShowCase Suite CD set can include up to four CDs:
ShowCase Suite 7.0 Base, ShowCase Essbase 7.1 (2 CDs), and/or ShowCase Analyzer 7.01. The 7.0
Base CD contains ShowCase Suite client applications, Warehouse Manager Server applications, and
Enterprise Reporting applications. The Essbase 7.1 CD contains Essbase applications. The Analyzer
7.01 CD contains Analyzer applications.

Send Us Your Comments

Your comments are important to us. Please tell us what you think about ShowCase Essbase
documentation by contacting:

Documentation Team
SPSS Inc.
4115 Highway 52 NW, Suite 300
Rochester, MN 55901-0144
Tel: (507) 288-5922
E-mail: DocumentationRoch@spss.com

Before You Upgrade

You may upgrade to ShowCase Essbase 7.1 from STRATEGY 4.5, STRATEGY Essbase 6.2,
STRATEGY Essbase 6.5, or STRATEGY Essbase 6.51.

1



2

Chapter 1

Upgrade Overview
We recommend you first upgrade your test environment to ShowCase Essbase 7.1 without using
new features. Then if you encounter problems during the upgrade process, it will be easier for
you and/or Technical Support to isolate the source of the problem. By introducing one change at a
time, you will likely identify any problems that occur as related to the specific change.

You will follow these general steps:

1. Save server information.

2. Duplicate and move all or a portion of your 4.5, 6.2, 6.5, or 6.51 production environment
into a test environment, and verify this test environment behaves similar to your production
environment. We recommend replicating your entire environment, including Warehouse Manager
Server, to accurately test the upgrade.

3. Install ShowCase Essbase 7.1 over the test library, and verify there are no problems (make sure
your results are accurate and performance time is as expected, for example).

4. Install ShowCase Essbase 7.1 over your existing production library.

With this method, most potential upgrade problems occur in a test environment without impacting
your production data warehouse or your end users. Though it takes time to set up and upgrade a
test environment before the actual upgrade, the test phase prepares you to handle any difficulties
before you begin your production upgrade.

To begin this process, see “Establishing a Test Environment” on p. 5 .

Common Upgrade Questions

What versions of OS/400 does ShowCase Essbase 7.1 require?

Version 5 Release 1 (V5R1), V5R2, or V5R3.

From which version(s) can I upgrade to ShowCase Essbase 7.1?

You can upgrade to ShowCase Essbase 7.1 from a STRATEGY 4.5 server or STRATEGY
Essbase 6.2, 6.5, or 6.51 servers.

Can I install the ShowCase Essbase 7.1 server on an iSeries running STRATEGY 3.x?

No. Upgrade from STRATEGY 4.5 or STRATEGY Essbase 6.2, 6.5, or 6.51.

Can ShowCase Essbase 7.1 client components connect to a 4.5, 6.2, 6.5, or 6.51 Essbase Server?

ShowCase Essbase 7.1 clients can connect to a 6.2, 6.5, or 6.51 Essbase Server. If you are
upgrading from 4.5, install the ShowCase Essbase 7.1 server before the 7.1 client components.
See Table 1 for server-client compatibility.
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Can 4.5, 6.2, 6.5, or 6.51 client components connect to the ShowCase Essbase 7.1 server?

Yes. In general, older clients can connect to newer servers, but they cannot access the new
server’s functions or features. Also, you must use the 7.1 clients to take advantage of the new
client features.

Can I open a ShowCase Essbase 7.1 database outline in an older Application Manager?

If you open and save a version 7.1 database outline using Application Manager version 4.5,
6.2, 6.5, or 6.51, Essbase deletes any 7.1 features from the outline. To open a 7.1 outline in an
older Application Manager, open the outline in read-only mode to ensure you do not lose the
version 7.1 features. To open the outline in read-only mode, uncheck Lock file in the application
desktop window.

Note: You cannot open ASO (Aggregate Storage) outlines in Application Manager. You must use
the Administration (EAS) Console.

Can I revert to older Essbase database files?

No. You cannot use 7.1 database files with older Essbase versions. If you need to revert to an older
version, delete the 7.1 database files and restore older database files from a backup of that version.

Does ShowCase Essbase Server 7.1 upgrade the Warehouse Manager Server or Warehouse
Manager client components?

No. This version upgrades your ShowCase Essbase Server and clients only. However, we
recommend replicating your current Warehouse Manager Server in a test environment to ensure
proper upgrade testing.

ShowCase Essbase 7.1 doesn’t upgrade Warehouse Manager Server. Why is Warehouse Manager
Server part of the upgrade plan?

For accurate testing, replicate your entire production environment in a test environment, including
your Warehouse Manager Server environment.

ShowCase Essbase 7.1 Prerequisites
Important: ShowCase Essbase functions only with the proper prerequisites. Before you upgrade,
verify your hardware and software meet the environment requirements in the ShowCase Essbase
Installation Guide, Chapter 3.

Patch Requirements

To avoid problems unrelated to migration, install the latest ShowCase Essbase patches onto your
current 4.5, 6.2, 6.5, or 6.51 version. For the latest patches, log on to the SPSS Technical Support
site at http://support.spss.com and click Patches.
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Note: Beginning with Essbase 6.5, SQL Drill-Through is no longer a client option. You must use
Essbase Integration Services (EIS) Drill-Through reports. For more information, see Hyperion’s
Essbase documentation.

Server-Client Connection Compatibility

The following tables list the supported combinations of servers and clients. Any combinations
not listed are not supported.

In general, older clients can connect to newer servers but cannot access new functions or features.
In some instances, newer clients can connect to older servers. For optimal migration, we
recommend all products be at the latest levels.

Table 1-1
Server-Client Connection Compatibility

Server Client Versions

ShowCase Essbase 7.1 Server Essbase clients 7.1, 6.51, 6.5, 6.2, 4.5 (Application
Manager, add-ins, and so on)
Analyzer 6.x or later

Table 1-2
Client-Server Connection Compatibility

Client Server Versions

ShowCase Essbase 7.1 Client Essbase Servers 7.1, 6.51, 6.5, 6.2

Table 1-3
Essbase-Warehouse Manager Client Compatibility

Essbase Version ShowCase Suite Client Versions

ShowCase Essbase 7.1 Server ShowCase Suite Clients (Warehouse Manager
Client, Warehouse Builder, Query/Report Writer)
7.0, 6.5/6.51, 4.5

To test Warehouse Manager Server compatibilities, see the applicable ShowCase upgrade guide at
http://support.spss.com/upgradeinfo/.

Documenting Your Upgrade

During your upgrade, we recommend documenting the actual steps you take on your iSeries
and PCs, problems that occur, and how you resolved those problems. Documenting is useful
for several reasons:

If you reach a point where you cannot proceed without help, SPSS Technical Support can use
your documentation to understand the background of the problem.

Subsequent upgrades are more precise because the steps you took the first time are recorded.
If you need to restart steps due to unforeseen circumstances or if you have multiple
installations to upgrade, you will be prepared.
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Notes:

When you perform OS/400 operations, use a PC with a terminal emulator (iSeries Access, for
example) so you can cut and paste iSeries commands and results into your word processor.
This avoids having to retype commands.

In Windows, to capture a bitmap image of the active window, you can use the key combination
Alt + PrtScn. To capture the entire display screen, press Ctrl + PrtScn. Then paste the
bitmap into your word processor.

Typical Production Scenario

Most data warehouse implementations follow a common architecture in which transaction data is
extracted, transformed, and loaded into a data warehouse containing DB2 Universal Database
(UDB) for iSeries (hereafter referred to as DB2 iSeries) tables and indexes, as in the following
figure.

Figure 1-1
Production Scenario: OLTP and Data Warehouse Environment

Connected PC

Relational Data Warehouse

Transaction OLTP Database

Multidimensional Data Marts

Production OLTP Data

Production Data Warehouse Environment

In the previous figure, the arrows represent Warehouse Builder distributions and ShowCase
Essbase loading operations. While your primary Warehouse Builder definitions will use source
tables from the transaction database, secondary definitions may use source tables from either the
transaction database or from the relational data warehouse (the target tables of other distributions).
You may have distribution sets that combine data sources from both the transaction system and
the data warehouse. Similarly, some of your queries and reports may reference the transaction
database directly, while others may reference the data warehouse tables only.

Establishing a Test Environment

To ensure your upgrade does not impact end users, you should establish a test environment
separate from your production environment. Then upgrade the test environment before upgrading
your production environment. This section guides you in preparing the test environment. After
you have established your test environment, the data warehouse architecture described in the
previous section will look similar to the following figure.
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Figure 1-2
Side-by-Side Test and Production Environments

Connected PC

Relational Data Warehouse

Transaction OLTP Database

Multidimensional Data Marts

Production OLTP Data

Production Data Warehouse Environment

Connected PC

Relational Data Warehouse

Multidimensional Data Marts

Test Data Warehouse Environment

Note the production environment on the left side of the diagram is unaffected by the test
environment on the right. The test environment draws source data from the same production
transaction database, but it writes data to an isolated relational and multidimensional data
warehouse. This structure allows for isolated verification of the upgrade process without
impacting the production environment.

Preparing a Test Environment

This section helps you create your test environment using these general steps:

1. Stop your servers and save your server information. For instructions, see the ShowCase
Administrator’s Guide and the ShowCase Essbase Administrator’s Guide available on the Support
web site at http://support.spss.com.

2. Install your current version of Essbase (4.5, 6.2, 6.5, or 6.51) into a test environment. Be sure to
install all the Essbase OLAP client components you plan to upgrade.

3. Populate the test environment with copies of your production objects.

4. Install ShowCase Essbase 7.1 “over the top” into the test environment.

To begin this process, see “Step 1: Create a ShowCase Essbase Test Environment” on p. 7 .

Ideally, to create an isolated environment you must separate hardware and software installations.
We recommend you designate one or more test PCs for your test environment, separate from
your production PCs. If your production PCs are running different operating systems, you may
want a separate PC for each of these. Alternatively, you may use a boot manager to allow for
more than one operating system on a single PC.

If you cannot allocate a separate iSeries for your test environment, you can install multiple
instances of ShowCase Essbase on the same server without conflicting with other servers.

Note: Per the licensing agreement, a separate partition is considered a separate server and
requires a separate license.
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Should I Establish a Test Environment on my Production iSeries or on a Separate iSeries?

Advantages to using the same iSeries (but not the same installation library) for both
production and test:

Environmental configuration settings are more likely to match. OS/400 PTF levels, work
management configurations, OS/400 system values, and so on, are common in both test and
production environments.

No need to duplicate source tables for queries, reports, or Warehouse Builder definitions on
another server.

Disadvantage to using the same server for both environments:

The test environment consumes resources such as DASD and/or processor, which may
compromise the production environment.

Advantage to using different servers for both environments:

Replicating your entire set of Essbase cubes is a simple save and restore operation.
Replicating your cubes in a new environment is more difficult when switching to a different
Essbase installation library, and separate servers allow both Essbase installations to use the
same library name.

Step 1: Create a ShowCase Essbase Test Environment

Note: If you install both ShowCase Essbase and Warehouse Manager (ShowCase) Servers, you
must install ShowCase Essbase first. Refer to the ShowCase Essbase Installation Guide at
http://support.spss.com for Essbase installation instructions.

Configure Your ShowCase Essbase IP Address

If you plan to install your test environment on the same iSeries as your production server, you must
establish unique IP addresses for each ShowCase Essbase server. When you installed ShowCase
Essbase, you were prompted to enter the IP address the ShowCase Essbase server would use for
client requests. If you specified *ALL, you will not be able to install multiple ShowCase Essbase
servers on the same OS/400 until you change this setting to a single, specific IP address.

To determine if your current Essbase server is configured with *ALL:

1. At an iSeries command line, type ESSBASE/SETENVVARS (where ESSBASE is the name of
your current Essbase library), and press Enter.

2. Type WRKENVVAR, and press Enter.

If the entry for ESSBASE_IP_ADDR is 0.0.0.0, the Essbase server is configured with *ALL. In
this case, if you plan to install your test environment on the same iSeries as your production
server, you must reconfigure your production Essbase server to use a specific IP address. To
do this, specify an IP address using the ESSBASE/CFGENVVARS command. The value must
be unique for each Essbase library.
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Secure a ShowCase Essbase Test Environment Serial Number

The ShowCase Essbase server does not allow short-term use of the server without a valid license.
To install and use a test ShowCase Essbase server, you need a serial number different from your
production serial number. You may purchase a development license (at a reduced cost compared to
a standard license). Contact your software provider for more information concerning this option.

Alternatively, if you licensed your software from SPSS, you may call 800-521-1337 to obtain a
temporary ShowCase Essbase serial number (password) to use during your upgrade process. A
ShowCase Essbase 7.1 password is also valid for older Essbase servers before upgrading.

You do not need a temporary license in two instances:

Your test and production Essbase servers are on separate iSeries so each server is using a
separate serial number. In this case, you probably have a unique license for each server.

You run your test server without running your production server so only one serial number is
being used (each active server must have a unique serial number).

Install Your Current Essbase Server into a Test Library

If you are installing your test server and production server on separate iSeries, install Essbase
(4.5, 6.2, 6.5, or 6.51) into a library with a name matching the Essbase library on your production
server, or install into a new library.

Important: If you are installing the test server on the same iSeries as your production server, you
must choose an Essbase library name different from your production Essbase library name.
However, choose a name containing the same number of characters as your production server
library. For more information, see “Step 3: Replicating Production Objects in a Test Environment
” on p. 9 .

Before finishing the test installation, complete the following steps:

1. To run the production and test Essbase servers simultaneously, enter an Essbase product serial
number different from your production serial number.

2. Copy the Essbase configuration file from your production server to your test server. The file name
is CFG, and the member name is ESSBASE in your Essbase installation library.

Note: If you are using Relational Storage Manager (RSM), you must migrate your application to
use either multidim storage or Hybrid. The RSM storage option is no longer available.

3. To compare environment variable settings to ensure they correspond, at an iSeries command
line type ESSBASE/DSPESSENV INFO(*ALL) (where ESSBASE is the name of your current
production Essbase library), and press Enter. Press the Page Down key until you see a line at
the bottom of the screen that reads “Essbase/400 Server attributes.” Place your cursor on the
message, and press F1. Compare the server attributes in the production environment with those in
the test environment.

4. After installing the test server libraries, apply the appropriate Essbase 4.5, 6.2, 6.5, or 6.51
patch to each server. To get the latest patches, log on to the SPSS Technical Support site at
http://support.spss.com and click Patches.
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Notes:

If you are using Essbase Integrated Security, you can use the same groups in both servers if
both test and production servers are on the same iSeries. If you are installing Essbase on a
separate test iSeries, you must create the necessary groups.

Do not create any Essbase applications at this point. In a subsequent step, you will replicate
some or all of your existing production Essbase applications on the test server.

Step 2: Create a Warehouse Manager Test Environment

Even though you are not upgrading the Warehouse Manager Server, we recommend replicating
your entire production environment in a test environment for accurate testing. Warehouse
Manager instructions are provided to help you set up a complete testing environment.

Note: Creating a Warehouse Manager test environment is required only if your test and production
environments are on separate iSeries servers.

Install Your Current Warehouse Manager Server into a Test Library

When you install your current Warehouse Manager Server version (4.5, 6.5/6.51, or 7.0) into your
test environment, choose installation options matching your production environment. You can use
side-by-side comparisons of Warehouse Manager Client screens to ensure settings are compatible
after installation. Adjust the settings in the test environment to match settings in your production
environment as appropriate. All the .cfg file settings should match.

Step 3: Replicating Production Objects in a Test Environment

The following sections explain how to copy some or all of your production objects to your test
environment.

Replicating Essbase OLAP Server Production Objects to a Test Environment

To replicate your production applications (or a subset of them) on your test server, use the SAV
and RST commands. If you choose to replicate only a subset of your applications, you can omit
some applications on either the SAV command or the RST command. If you use a regular backup
image in the replication, you will likely subset on the RST command; otherwise, it will save time
to subset on the SAV command. This also minimizes the size of the save image.

You can find more detail on saving and restoring Essbase in the ShowCase Essbase
Administrator’s Guide available on the Support web site at http://support.spss.com.

To replicate the objects:

1. Stop the production Essbase server.

2. At an iSeries command line, use a SAV command such as the following to save some or all of your
applications from your production Essbase server. In the following sample command, ESSBASE
is your server library and App1 and App2 are names of applications that will not be replicated.
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SAV DEV(path to save device or save file) OBJ(('/ESSBASE')
('/ESSBASE/app/App1' *OMIT) ('/ESSBASE/app/App2' *OMIT))

3. Restart the production Essbase server.

4. If you created any applications in your test server, delete them using Application Manager or
Esscmd.

5. Stop the test Essbase server.

6. Use an RST command such as the following to restore some or all of your applications. If the
installation library names for your test and production servers are the same (that is, if you used
different iSeries for your test and production environments), skip this step, and skip step 7 as well.

Note: If you are not replicating all your applications, and you used the *OMIT option in the SAV
step above, do not use the lines containing the *OMIT option in this step. In the following sample
command, ESSBASE is your server library, ESSTEST is the new directory, and App1 and App2
are the names of applications that will not be loaded.

RST DEV(path to save device or save file) OBJ(('/ESSBASE'
*INCLUDE '/ESSTEST' ) ('/ESSBASE/app/App1' *OMIT) ('/ESSBASE/app/
App2' *OMIT) )

7. To update the test server installation library, use the “Change Essbase Library” (CHGESSLIB)
utility:

E Add your Essbase Server library to your library list.

E Run the following iSeries command:

CALL CHGESSLIB

E When prompted, enter the name of the Essbase installation library for which the SAV was done.

E When prompted, enter the name of the Essbase installation library for which the RST was done.

Note: The source and target directories must contain the same number of characters.

When the utility has finished processing, your test server installation library will be updated.

8. Delete the contents of the Essbase/bin/applinks directory. To do this, type the command RMVLNK
‘/ESSTEST/BIN/APPLINKS/*’ (where ESSTEST is the new directory).

9. Start the Essbase test server.

If you restored a subset of your applications, you may receive error messages in Application
Manager when you attempt to work with applications you did not restore.

10. Open each rule file to verify the source tables and views referenced in the SQL statements
correctly correspond to the tables in your test environment data warehouse.

11. If you used non-SQL references, you may need to update Esscmd or MaxL scripts to reference
the test environment tables or files.
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Replicating Essbase Integration Server (EIS) Production Objects to a Test Environment

If one or more of your Essbase OLAP databases were created using Essbase Integration Services
(EIS), you must follow the steps below to replicate the Integration Server objects into a test
environment.

You can find more details, such as information on saving and restoring, in the ShowCase Essbase
Administrator’s Guide.

To replicate the objects:

1. Ensure the Essbase Integration Services (EIS) Server and OLAP Server are running (both the test
server and the production server).

2. From a Windows PC, use the Essbase Integration Services console to create an OLAP metadata
catalog on the test server.

3. Connect to your production server (running Essbase 6.5 or 6.51).

4. In the Essbase Integration Services (EIS) Console, from the File menu, select XML Import/Export.
On the Export tab, select each OLAP model and metaoutline and export each one to a unique
.xml file.

Note: You can save the .xml files to your local drive or to the iSeries integrated file system (IFS).

5. Disconnect from your production server.

6. Connect to your test servers (running Essbase 6.5 or 6.51). You must connect to both the EIS
Server and the OLAP Server.

7. In the Essbase Integration Services (EIS) console, from the File menu, select XML Import/Export.
On the Import tab, select each OLAP model and metaoutline you exported previously and import
each one to the test environment.

8. In the Essbase Integration Services (EIS) console, from the File menu, select Open. On the
Existing tab, open each OLAP metaoutline, one at a time. Once a metaoutline is opened, from
the Outline menu, select Member and Data load. Specify an application and database name. This
creates an Essbase application/database in your test environment.

Repeat this process for each database.

Transferring Warehouse Manager Objects from Production to Test

Note: This section is required only if your test and production environments are on separate
iSeries servers. Use the following steps to replicate all or a subset of your objects from the
production Warehouse Manager Server on the test server:

1. Be sure all end users have disconnected from the Warehouse Manager Server.

2. Stop the production Warehouse Manager Server. For instructions, see the ShowCase
Administrator’s Guide, Chapter 2, “Starting and Stopping the Servers.”

3. Save production server library information with the command SERVERLIB/SAVSRVRINF (where
SERVERLIB is the name of your Warehouse Manager Server production library).**
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4. Restart ShowCase TCP/IP for your production server.

5. Stop the test servers.

6. Restore the information from the production library to the test server library with the command
SERVERLIB/RSTSRVRINF.

7. Start the test server.

**For information on the SAVSRVRINF and RSTSRVRINF commands, see the ShowCase
Administrator’s Guide

Important: If you have Warehouse Builder definitions, you may need to adjust the libraries and/or
table names in the transferred test definitions so target tables generated by the test environment are
distinct from those generated by the production environment. To do this, establish a test library for
each target library referenced in your definitions. Secondary Warehouse Builder definitions may
need source table names or libraries adjusted in a similar manner. To adjust them, open Warehouse
Builder, connect to the test server, and with no objects open, select Definition Properties from the
Tools menu. For more information about this dialog, see the Warehouse Builder online help.

Step 4: Install Your Current Version of ShowCase Suite (STRATEGY) on Test PCs

Install your current version of STRATEGY (4.5 or 6.5/6.51) on one or more test PCs, and
configure ODBC connections to the test servers. If you need additional information, use the
ShowCase Installation Guide, Chapter 6. Information on configuring server connections is in the
ShowCase Essbase Administrator’s Guide, Chapter 3.

Notes:

If you are upgrading from STRATEGY Essbase 6.2, you should install 4.5 client components
and then 6.2 client components.

Apply patches at the same level as on your production PCs. For the latest patches, log on to
the SPSS Technical Support site at http://support.spss.com/ and click Patches.

Step 5: Verify Your Test Environment

You should now have a working test environment, ready to perform tests to ensure your test
environment behaves like your production environment. It is important to verify the test
environment before upgrading. If you upgrade without testing and problems occur, it will be
difficult to determine if the problem is a result of the test environment setup or the upgrade.

If your test and production environments are on the same server, use a test user profile without
access to the production data warehouse to ensure the test environment is correctly adjusted
to refer to the test data warehouse.

If you have not yet made use of some features in a production environment, verify security
settings are in place and operational. You can adjust them in Warehouse Manager Client
or Essbase Application Manager.



13

Upgrading to ShowCase Essbase 7.1

For Warehouse Manager Server, make sure you can run Warehouse Builder distributions,
queries, reports, views, and so on. Verify you can create new objects and change existing
objects.

For Essbase Server, make sure you can start, end, and load applications and databases as
usual. You should not have to modify load rules or outlines. Make sure your calculation
behaves properly in accuracy and performance.

Saving the Test Environment

Saving the test environment ensures you can restart if problems occur during your test upgrade.
To properly back up your test environment, see the ShowCase Administrator’s Guide and
ShowCase Essbase Administrator’s Guide.

Upgrading the Test or Production Environment

At this point, you are ready to test the upgrade process with your environment. If problems arise,
first resolve them and then retest to avoid introducing other problems. This section describes
how to upgrade to ShowCase Essbase 7.1. You will use this section twice: once for the test
environment and once for your production environment.

If you have not already done so, apply the appropriate ShowCase Essbase Server patches
to your environment. For the latest patches, log on to the SPSS Technical Support site at
http://support.spss.com and click Patches.

Step 1: Stop Servers

1. To stop the Warehouse Manager Server, use the iSeries command SERVERLIB/ENDSCSVR where
SERVERLIB is the name of the library where the servers are installed.

2. To stop the Essbase servers, use the iSeries command ESSBASE/ENDESSSVR where ESSBASE is
the name of your current Essbase library. Supply a user ID and password.

Step 2: Back Up Server Information

Important: Disaster recovery backups could prevent data loss. Always save server information
before you install over any version. This way, if there are problems with the installation, you
can restore your data from a backup. To back up your server environment, see the ShowCase
Administrator’s Guide and the ShowCase Essbase Administrator’s Guide available on the Support
web site at http://support.spss.com.

Step 3: Install ShowCase Essbase 7.1 Server

1. After stopping the servers, install ShowCase Essbase 7.1 into the existing Essbase libraries.
For step-by-step server installation instructions, use the ShowCase Essbase Installation Guide,
Chapter 5.
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2. Check for any available server patches. For the latest patches, log on to the SPSS Technical
Support site at http://support.spss.com and click Patches.

3. After installation, start your server(s). For information on starting the servers, see the ShowCase
Essbase Administrator’s Guide, Chapter 2.

Step 4: Install ShowCase Essbase 7.1 onto PCs

Before upgrading to 7.1, be sure the corresponding Essbase OLAP client components are installed
on PCs. Follow instructions in the ShowCase Essbase Installation Guide, Chapter 6. Use the
following information as a guide.

Installing on Network PCs

There are two ways to upgrade in your Local Area Network (LAN):

Method 1: Install from CD directly onto user PCs.

Method 2: Install to the network so users can install or run 7.1 on their PCs.

See the ShowCase Essbase Installation Guide, Chapter 3.

Note: ShowCase Essbase 7.1 does not support “silent” installations.

Step 5: Start Applications

When pre-7.1 applications are started for the first time after Essbase 7.1 is installed,
some application and database files are processed to convert EBCDIC-encoded strings to
ASCII-encoded strings for compatibility with the 7.1 server. The process creates temporary
copies of those files and requires that your system have additional available space — the size of
your largest Essbase database. This typically happens no more than two times.

Also, the process will take extra time. Plan for approximately 4 to 8 minutes for each 2 GB of
data. Results may vary depending on system configuration. Because of this, we recommend
starting your applications as part of the upgrade process.

Step 6: Upgrade your EIS Catalog

If you are upgrading Essbase Integration Server 6.5 or 6.51, the catalog must be upgraded before
you can connect to the Integration Server using a 7.1 EIS client. Update (or migrate) your catalog
with the following instructions. Note that if you are at the latest 6.51 patch level (6.51.060 or
later), no migration is required.

1. Open the EIS Console.

2. From the Tools menu, select Create Catalog.

3. If a catalog does not exist, it will create a new catalog. If a 6.5 or 6.51 (pre-6.51.060) catalog is
detected, it will be migrated to version 7.1.
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Step 7: Verify the 7.1 Upgrade

Be sure ShowCase Essbase features work correctly in your environment. You should verify:

All Essbase applications start properly.

Essbase calculation runs properly.

Essbase applications return valid reports.

If you are also using Warehouse Manager and Warehouse Builder, verify sets and definitions
work properly.

If you have just completed the “test” upgrade using your test environment, review your work.
Ensure you understand any difficulties you encountered during the test upgrade and how to
resolve those difficulties when you upgrade the production environment. Once you have a
complete upgrade plan, upgrade your production environment, beginning at “Upgrading the
Test or Production Environment” on p. 13.
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